Queries
A query is a basic tool that Access provides for retrieving information from your database. It allows you to take information from single or multiple tables to obtain the data you want. Each query functions like a question that can be asked immediately or saved to be asked later. Although this question will generally remain unchanged (unless you choose to edit the query), the altering nature of your database means that the answer Access provides will generally be different each time the query is run. This section covers advanced topics, including using queries to sort and modify data.

Types of queries
You can use queries to view, change, and analyze data in different ways. In addition, you can use them as a source of records for forms, reports, and data access pages. There are several types of queries in Microsoft Access.

*Select Queries*
The most common type of query, select queries retrieve data from one or more tables (using criteria you specify) and display the results in a datasheet. Select queries may be used to group records as well as perform calculations including sums, counts and averages.

*Parameter Queries*
When run, a parameter query displays its own dialogue box prompting you for information, such as criteria for retrieving records or a value you wish to insert in a field.
Crosstab Queries
You can use crosstab queries to calculate and restructure data for easier analysis. Use a crosstab query to calculate a sum, average, count, or other type of total for data that is grouped by two types of information.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>Category Name</th>
<th>Sum of Subtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buchanan</td>
<td>Beverages</td>
<td>$ 46,302.09</td>
</tr>
<tr>
<td>Buchanan</td>
<td>Condiments</td>
<td>$ 16,789.35</td>
</tr>
<tr>
<td>Buchanan</td>
<td>Confections</td>
<td>$ 36,122.13</td>
</tr>
<tr>
<td>Callahan</td>
<td>Beverages</td>
<td>$111,047.76</td>
</tr>
<tr>
<td>Callahan</td>
<td>Condiments</td>
<td>$ 49,566.21</td>
</tr>
<tr>
<td>Callahan</td>
<td>Confections</td>
<td>$ 80,005.35</td>
</tr>
</tbody>
</table>

Note: The select query only groups totals vertically by employee and category, resulting in more records and making comparisons between totals more difficult. A crosstab query displays the same information, but groups both vertically and horizontally so the datasheet is more compact and easier to analyze.

Action Queries
An action query uses just one operation to make changes to, or moves many records. There are four types of action queries: Delete, Update, Append, and Make-Table Queries.
Creating a query in design view

Most of the queries described may be created using a query wizard. However, design view is useful for creating more complex queries and for revising existing queries.

- In the **Database** window, click on the button labeled **Queries**.
- The **Queries** area will appear.
- Double-click on the icon labeled **Create query in Design view**.

- The **Show Table** window will appear.
• Click on the name of the data source you wish to add to your query.
  o Tables can be added by clicking on the tab labeled Tables.
  o Pre-existing queries can be added by clicking on the tab labeled Queries.
• Click on the button labeled Add.
• Repeat these steps for each table or query you wish to add.
• After you have added your data source(s), click on the button labeled Close.
• The Query window will appear.
• Double-click on the field’s name in one of the table windows at the top of the Query window.
• Each field will be added to the design grid located at the bottom of the Query window.

![Query window diagram]

The top pane displays the data sources available to the query and any relationships
The design grid displays fields added to your query as well as where the field originated from

• The fields, sort order, and criteria you add to the design grid determine what you will see in the query’s results.
• Click on the Save button to name your query.

![Save button]

• Click on the Run button to switch from Design mode to View mode as well as to see the results of your query.

![Run button]
Once you are in View mode, click on the Run button again to return to Design mode.

Creating a parameter query
Parameter queries are interactive filters that allow you to specify a different filter criterion every time you open up the query. You can design the query to prompt you for more than one piece of information; for example, you can design the query to prompt you for two dates. Access will then retrieve all records that fall between those two dates.

- Open up an existing query in Design mode.
- Decide which field you wish to use in your filter.
- In the design grid, click in the field’s Criteria cell.
  - If your parameter query requires an operator, type that operator in the Criteria cell (For a complete description of operators, please see page 10 in this guide).
  - Complete your filter expression with a text phrase in square brackets. This bracketed phrase should describe the variable value you will be asked to supply every time the query is opened.

- Continue to add criteria in the appropriate fields to complete your query.
- Click on the Save button located on the toolbar.
- Click on the Run button to test your query.
• The **Enter Parameter Value** window will appear for each criterion that has to be specified.

![Enter Parameter Value window]

• Enter the numeric value you wish to use in your filter.
• Click on the button labeled **OK**.
• Access will run the query and retrieve your data from the database. The following chart displays the results for a filter designed to retrieve employees with a salary less than or equal to $60K.

![Employee Information Query: Select Query]

**To run your parameter query**
Do one of the following:
• From the **Database** window:
  o Click on the button labeled **Queries**.
  o Select the parameter query you wish to run.
  o Click on the button labeled **Open**.

![Database window with Queries selected]
• From the **Query Design** mode:
  o Click on the **View** button.
  o From the drop-down menu that appears, select **Datasheet View**.

![Datasheet View](image)

• The **Enter Parameter Value** window will appear for each parameter in the query.
• Do one of the following for each parameter value you are prompted for:

<table>
<thead>
<tr>
<th>To Enter . . .</th>
<th>Type . . .</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Parameter Value</td>
<td>The Value</td>
<td>A value specified by the user</td>
</tr>
<tr>
<td>The Default Value</td>
<td>&lt;DEFAULT&gt;</td>
<td>A value that is automatically entered in a field when a new record is added</td>
</tr>
<tr>
<td>A Null Value</td>
<td>&lt;NULL&gt;</td>
<td>A value you can enter in a field to indicate missing or unknown data</td>
</tr>
<tr>
<td>A Blank String</td>
<td>Leave blank</td>
<td>Indicates that no known value exists for a field</td>
</tr>
</tbody>
</table>

**Tip**: Parameter queries are helpful when used as the basis for forms, reports and data access pages. For example, you can create a monthly earnings report based on a parameter query. When you print out the report, Access displays a dialogue box asking for the month that you want the report to cover. Once you enter the desired month, Access will print the appropriate report.
Creating a crosstab query

1. Open up an existing query in **Design** mode.
2. Click on the **Query Type** button located on the toolbar.
   - From the drop-down menu that appears, select **Crosstab Query**.

A **Crosstab** row will appear in the design grid.

- For the field(s) whose values you want to appear as row headings:
  - Click on the down-facing arrow next to the box labeled **Crosstab**.
  - From the drop-down menu that appears, select **Row Heading**.
Repeat these steps for each field you desire to use as a row heading in the query.

*Tip:* In the row labeled **Total**, you must leave the default, **Group By**, for these fields.

- For the field(s) whose values you want to appear as column headings:
  - Click on the down-facing arrow next to the box labeled **Crosstab**.
  - From the drop-down menu that appears, select **Column Heading**.

  ![Diagram](image)

  *Tip:* You can select **Column Heading** for one field only, and as with Row headings, you must leave **Group By** in the row labeled **Total** for this field.
Customizing Crosstab query column headings
By default, column headings are sorted in alphabetic or numeric order. In certain cases, you may wish to change the order or limit the column headings in a crosstab query. For example, in column headings containing the months of the year, you can display the months chronologically rather than alphabetically. You can also limit the columns to only January through June. To edit crosstab query headings:

- Open up the crosstab query in **Design** view
- Click in the background of query design view.

- Click on the **Properties** button located on the toolbar.

- The **Query Properties** window will appear.
• In the box labeled **Column Headings**, type the column headings you wish to display.
  o Enter the column headings in the order in which you want them to be displayed.
  o Place a comma between each column heading.

**Tip:** Column headings must be entered exactly as they appear in the query datasheet. For example, if a column heading in the datasheet is "USA," you must enter a column heading of "USA"—not "US." After you click on the key labeled ENTER or move the cursor to a different location, Microsoft Access places quotation marks around each heading.

• Click on the **View** button to view the query's results.

Creating action queries
Queries may also be used to change, retrieve, and display data. These action queries perform specific operations and can be an efficient tool for making modifications to bulk data. There are four types of action queries:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes a group of records from one or more tables</td>
</tr>
<tr>
<td>Update</td>
<td>Makes global changes to a group of records in one or more existing tables</td>
</tr>
<tr>
<td>Append</td>
<td>Adds a group of records from one or more tables to the end of another table(s)</td>
</tr>
<tr>
<td>Make-Table</td>
<td>Creates a new table from all or part of the data in other tables</td>
</tr>
</tbody>
</table>

Before creating an action query, it is good practice to run a select query to determine how the action query will affect your records and the appropriate criteria to create the desired result.
Delete Queries

- Create a **Select Query** in **Design View** to determine the records that will be deleted.
- From the **Database** window:
  - Click on the button labeled **Queries**
  - Double-click on **Create query in Design view**.

- Modify the query by adding the appropriate data source(s) and criteria. In this example, a shipping company has determined that it can cut costs by not routing through its Nevada distributors, and must accordingly cut them out of their database.

- Click on the button labeled **View** to bring up a list of the retrieved records.
The Select Query window will appear, displaying fields that will be altered by the action query.

Click on the View button to return to Query Design View.

If necessary, further modify the query so the proper fields will be deleted.

Click on the Query Type button.

From the drop-down menu that appears, select Delete Query.

The Delete Query window will appear.
• Click on the **Run** button.

![Warning message](image)

• A **Microsoft Office Access** window will appear, warning that fields from the table will be deleted.

• Click on the button labeled **Yes**.

![Yes/No button](image)

• The **Table** window will appear, displaying the delete query results (in the example below, arrows point out the deleted queries).

![Table window](image)

• Click on the **Save** button if you are satisfied with the action query results.

![Save button](image)

**Tip:** Note that delete queries always delete entire records, not just selected fields within records.
Update Queries

- Create a Select Query in Design View to determine the records that will be updated.
- From the Database window:
  - Click on the button labeled Queries.
  - Double-click on Create query in Design view.

- Modify the query by adding the appropriate data source(s) and criteria. In this example, a shipping company has determined that it will increase the minimum maximum weight of shipped packages from 200lbs to 300lbs.

- Click on the View button to bring up a list of the retrieved records.
• The **Select Query** window will appear, displaying the fields that will be altered by the action query.

![Select Query Window](image)

• Click on the **View** button to return to **Query Design View**.

![View Button](image)

• If necessary, modify the query further so that the proper fields will be updated.
• Click on the **Query Type** button.
• From the drop-down menu that appears, select **Update Query**.
• The **Update Query** window will appear.
• In the field labeled **Update To**, type in the value you wish to change the altered fields to. In this example, the minimum ‘max weight’ of packages will be increased from 200 to 300lbs.

![Update Query window](image)

• Click on the **Run** button.

• A **Microsoft Office Access** window will appear, warning that fields from the table will be updated.
• Click on the button labeled **Yes**.
• The Table window will appear, displaying the update query results (in the example shown below, the arrows correspond to the updated queries).

![Table Window](image)

• Click on the Save button if you are satisfied with the action query results.

![Save Button](image)

**Make-Table Queries**

A Make-Table Query is slightly different from the other action queries. Instead of modifying data within an existing table, a Make-Table Query creates a new table from the query results. In this example, a consumer, who happens to have all their CDs recorded in a database, decides to organize his CD collection. To do this, he may wish to have a table containing only the CDs located at home.

![Table Window](image)
• Create a **Select Query** in **Design View** to determine the records that will be used to create a new table.
• From the **Database** window, click on the button labeled **Queries**.
• Double-click on Create query in Design view.

![Database window with Queries selected](image)

• Modify the query by adding the appropriate data source(s) and criteria.

![Query design window](image)

• Click on the **View** button to bring up a list of the retrieved records.
• The Select Query window will appear, displaying the fields that will be altered by the action query.

![Select Query Window]

• Click on the **View** button to return to Query Design View.

• If necessary, modify the query further so the proper fields will be included in the new table.
• Click on the **Query Type** button.
• From the drop-down menu that appears, select **Make-Table Query**.
• The Make Table window will appear.
• In the box labeled Table Name, type the name you wish to give to the new table.
• Click on the option button to select whether the new table will be created in the Current Database or Another Database.
• Click on the button labeled OK.

![Make Table Window]

• The Make Table Query window will appear.

![Make Table Query Window]

• Click on the Run button.

![Warning Message]

• A Microsoft Office Access window will appear, warning that a new table will be created using the selected records.
• Click on the button labeled Yes.
The **Database** window will appear.

Note that a new table has been created with the desired name.

Click on the new table name to select it.

Click on the button labeled **Open** to view the new table.

Click on the **Save** button if you are satisfied with the make-table query results.

**Tip:** Make-table queries are helpful for creating a table to export to other Access databases, or to a history table that contains old records.
Append Queries
In this example, our consumer decides to buy several CDs from a friend. This friend also happens to have all their CDs organized in a database, making it easy to transfer the records along with the sale. The seller’s database ‘LDM Music Table’ is shown below:

- Create a Select Query in Design View to determine the records that will be appended.
- From the Database window:
  - Click on the button labeled Queries.
  - Double-click on Create query in Design view.
• Modify the query by adding the appropriate data source(s) and criteria. We will design a query to retrieve the ‘sold’ albums from the seller’s database.

![Image of a query window showing fields and criteria]

• Click on the View button to bring up a list of the retrieved records.

![Image of a query window with records]

• The Select Query window will appear, displaying fields that will be altered by the action query.

![Image of a query window with fields and criteria]

• Click on the View button to return to Query Design View.

![Image of a query window showing the view button]

• If necessary, modify the query further so the proper fields will be appended.
Click on the Query Type button. From the drop-down menu that appears, select Append Query.

The Append window will appear. Click on the downward-facing arrow next to the box labeled Table Name. From the drop-down menu that appears, select the table to which you wish to add the retrieved fields. Click on the option button to select whether the new table will be created in the Current Database or in Another Database. Click on the button labeled OK.

The Append Query window will appear.
• Click on the Run button.

• A Microsoft Office Access window will appear, warning that the retrieved fields will be appended.
• Click on the button labeled Yes.

• The Database window will appear.
• Click on the name of the table to which the fields were appended.
• Click on the button labeled Open to view the selected table.
- The **Table** window will appear.

  ![Table Window](image)

<table>
<thead>
<tr>
<th>Tracking</th>
<th>Artist</th>
<th>Album Name</th>
<th>Released</th>
<th>Location</th>
<th>Notes</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Farm Dogs</td>
<td>Immigrant Sons</td>
<td>1998</td>
<td>Home</td>
<td>2nd album</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>John Fogerty</td>
<td>Blue Moon Swamp</td>
<td>1997</td>
<td>Car</td>
<td>live</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Blindfolded Ladies</td>
<td>Shout</td>
<td>1998</td>
<td>Office</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>OP/PR</td>
<td>OP/PR</td>
<td>1996</td>
<td>Home</td>
<td>Crosby &amp; son</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Elton John</td>
<td>Tumbleweed Connection</td>
<td>1991</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Sting</td>
<td>Bring on the Night</td>
<td>1995</td>
<td>Car</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Fleetwood Mac</td>
<td>Rumors</td>
<td>1997</td>
<td>Home</td>
<td>great disc</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Pink Floyd</td>
<td>The Wall</td>
<td>1992</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>The Killers</td>
<td>Hot Fuss</td>
<td>2004</td>
<td>Car</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>The Flaming Lips</td>
<td>Yoshimi Battles the Pink</td>
<td>2002</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Fleetwood Mac</td>
<td>Rumors</td>
<td>1997</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Yes</td>
<td>Close to the Edge</td>
<td>1972</td>
<td>Office</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Dave Matthews E</td>
<td>Crash</td>
<td>1996</td>
<td>Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Michael Jackson</td>
<td>The Essential Michael J</td>
<td>2005</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Dave Matthews E</td>
<td>Under the Table and Drea</td>
<td>1984</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Red Hot Chili P</td>
<td>Californication</td>
<td>1989</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Stone Apple</td>
<td>Total</td>
<td>1996</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Dave Matthews E</td>
<td>Live at Red Rocks</td>
<td>1997</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Jay-Z</td>
<td>The Black Album</td>
<td>2003</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Note that the retrieved fields have been added at the end of the table and that the values are appended only in matching fields.
- Click on the **Save** button if you are satisfied with the append query results.

**Tip:** To run an action query, use the **Run** button rather than the **View** button. Using View will bring up a list of all records that will be updated, but not display their new values. Using Run will update the values.
Sorting data
Add criteria to a query
Incorporate comparison operators and conditional operators to access more information.

Comparison Operators
Including comparison operators in an expression allows one data value to be compared against another.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equals</td>
<td>= '11/29/1961'</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td>&lt; 'K'</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
<td>&lt;= 2500</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td>&gt; 'K'</td>
</tr>
<tr>
<td>&gt;-</td>
<td>Greater than or equal to</td>
<td>&gt;- 2500</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to</td>
<td>&lt;&gt; 'Illinois'</td>
</tr>
<tr>
<td>Between_ And_</td>
<td>Within a Range</td>
<td>Between 2 and 9</td>
</tr>
<tr>
<td>Is Null</td>
<td>Null values</td>
<td>Is Null</td>
</tr>
</tbody>
</table>

Conditional Operators
Conditional operators, also referred to as logic operators, add the ability to evaluate the truth of an expression, thus increasing flexibility and power.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>True if both conditions are true</td>
<td>&gt;5 AND &lt;&gt;100</td>
</tr>
<tr>
<td>OR</td>
<td>True if either condition is true</td>
<td>&lt;5 OR &gt;500</td>
</tr>
<tr>
<td>NOT</td>
<td>True if the single instance is not true</td>
<td>NOT Between 2 And 5</td>
</tr>
</tbody>
</table>
Add a calculated field to a query
Calculated controls allow you to make a mathematical calculation or join multiple strings of text when you run your query.

**Numeric calculations**
To create a new calculated control:
- Click in an empty Field cell in Query Design View.
- Type the name of the newly-calculated result, a colon, and the formula you wish to calculate. Refer to any fields in your calculation by entering their names surrounded by square brackets. You can use the following mathematical operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
</tbody>
</table>

- For example, to calculate the amount of money paid to each employee per month, type:
  - Monthly Pay Rate:[Salary]/[Number of months worked]

- Save your query.
- Use the View button to check the results and troubleshoot your calculation as necessary.
Concatenation

To create a new calculated control:

- Click in an empty Field cell in Query Design View.
- Type the name of the newly-calculated result, a colon, and the formula you wish to calculate. Refer to any fields in your calculation by entering their names surrounded by square brackets. Incorporate any text that will not change (including spaces) inside quotation marks. Use an ampersand character (&) to join any two strings of text in your expression (one fields with another, the contents of a field with text in quotations, etc.)
- In this example, type the following to concatenate the First Name and Last Name fields. (Note that space within the quotation marks.)
  - FullName:[First Name] & “ ” & [Last Name]

- Save your query.
- Use the View button to check the results and troubleshoot your calculation as necessary.

Sort query results

Access allows you to sort data retrieved by a query so it will be displayed in a logical order.

- Open up an existing query in Design mode.
- Locate the field you wish to use to sort your data.
- In the previous example, qry_filter test asks the question “Who do I employ, and what is each one’s salary?” One reasonable way to sort the retrieved data in decreasing order by rate of pay.
• Click on the down-facing arrow next to the **Sort** cell.
• From the list that appears, select the sort order you wish to apply to your query.

<table>
<thead>
<tr>
<th>Salary</th>
<th>EmployeeInformatic</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Ascending</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Descending</strong></td>
<td></td>
</tr>
<tr>
<td>(not sorted)</td>
<td></td>
</tr>
</tbody>
</table>

• An ascending sort order will sort data from the **smallest** to the **largest** value in the sort field.
• A descending sort order will sort data from the **largest** to the **smallest** value in the sort field.
• Click on the **Save** button.
• Click on the **View** button to switch from Design mode to **View** mode and see the results of your query.
Customizing Reports
Reports are printable summaries of the information in your Access tables and queries. They may be created by using a wizard; however, Design View provides the user the ability to enhance the appearance of reports beyond the options provided through the reports wizard.

Adding subtotals to your report
A sales report can include a lot of numbers. That is why you will need to calculate sums at the appropriate locations in a report.

- Open up your report in Design View.

- To insert a subtotal, a calculated field should be placed in the group header or footer. In the report above, the group would be the ‘Company’.
- To calculate a total for an entire report, place a calculated field in the report header or footer.
Inserting a subtotal
A group header is used to place information, such as a group name or group total, at the beginning of a group of records. Likewise, a group footer places such information at the end of a group of records on a report. Both may be used as a location for subtotals. To add a group header or footer on a report:

- Click on the **Sorting and Grouping** button, located on the toolbar.
  
  ![Sorting and Grouping window](image)

- The **Sorting and Grouping** window will appear.

- Click on a row in the **Field/Expression** column.
  - To add a group header section, set the **Group Header** property to **Yes** (in the lower portion of the dialog box).
  - To add a group footer section, set the **Group Footer** property to **Yes**.
- Click on the red X in the upper right-hand corner of the dialogue box to close the window and return to **Design View**.
• Note that the new section, **Company Footer**, has been added.

• From the **Toolbox**, click on the **Text Box** button.

• Draw a text box in the group footer section of the report.
• With the new textbox selected, click on **View**.
• From the drop-down menu that appears, select **Properties**.
The **Text Box** report window will appear.

![Text Box: Text33](image)

- Click on the tab labeled **Data**.
- Click in the box labeled **Control Source**.
- To calculate the subtotal of computers ordered by each company, type the expression,

  \[
  \text{=Sum([NoComputersOrdered])}
  \]

- The **Sum** function calculates the total for a set of values from your record source, in this case: the column named **NoComputersOrdered**.

![Company Footer](image)

**Tip:** To define the area between the details section for the group and the calculated subtotal, add a line in design view using the **Line Tool** located in the **Toolbox**.

- To see how your report is affected, click on the **View** button, located on the toolbar.

![View button](image)
The will **Report** window will appear.

**Tip:** To define the area between the details section for the group and the calculated subtotal, add a line in design view using the **Line Tool** located in the **Toolbox**.
Inserting a total
To calculate a total for an entire report, place a calculated field in the report header or footer. To add a report header or footer:
• From the View menu, select Report Header/Footer.
• Note that **Report Header** and **Footer** sections have been added in design view.

• From the **Toolbox**, click on the **Text Box** button.

• Draw a text box in the report footer section.
• With the new textbox selected, click on the menu labeled **View**.
• From the drop-down menu that appears, select **Properties**.

![Image of drop-down menu with Properties selected]

• The **Text Box** report window will appear.

![Image of Text Box report window]
Click on the tab labeled **Data**.
Click in the box labeled **Control Source**.
To calculate the total quoted computer prices for all companies, type the expression,

\[ \text{Sum(}[\text{QuotedPricePerComputer}]) \]

The **Sum** function calculates the total for a set of values from all record sources, in this case: the column named **QuotedPricePerComputer** for all companies included in the report.

Use the grid to position the computational field and label in the appropriate place in the report footer.

**Tip:** To emphasize the report total, add a line in design view using the **Line Tool** located in the **Toolbox**.
• To see how your report is affected, click on the **View** button.

• The will **Report** window will appear, allowing you to preview any changes or additions made.
Changing the appearance of reports

Design Sections

- **Detail Section:** This section, by default, is included in every form you create and is the only section seen when **Design View** is first opened. Once your report is complete, the Detail section will include the bulk of data from your database, including group headers and footers.

- **Header and Footer Sections:** In addition to data in your **Detail** section, you may wish to add header and footer sections to your form.
  - **Headers** will often contain titles & logo graphics.
  - **Footers** will often contain instructions for using the form, modification dates, and the designer’s name.

- To summarize, there are three types of headers and footers that can appear on a report:

<table>
<thead>
<tr>
<th>Header/Footer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Appear once each at the beginning and end of the report</td>
</tr>
<tr>
<td>Page</td>
<td>Appear at the top and bottom of each page</td>
</tr>
<tr>
<td>Group</td>
<td>Included in the <strong>Detail</strong> section</td>
</tr>
</tbody>
</table>
• To add a **header/footer** section to your report:
  o From the **View** menu, select the name of the section you wish to add.

• To hide a **header/footer** section:
  o From the **View** menu, select the name of the section you wish to hide.
  o When a section is displayed it is marked with a check in the **View** menu. Conversely, a hidden section appears without a check.

**Resize a section of the report**

If the report materials you wish to insert do not fit comfortably into a section, you can easily resize any section of your report.

• Place your cursor at the bottom of the section you wish to resize so that the **double-arrow** cursor is displayed.
• Drag the cursor upward or downward to resize the section.
Create a report title
To give your report a title or add any other additional passages of text, you must create a label box:

- Click the Aa button located on the Toolbox.

- Draw an area with the cursor in the Report Header section by clicking and dragging. You can always adjust the size of the box after your text has been typed.

Moving text boxes and labels

Move a text box and its label together

- Click on either the label or the text box. Notice that the perimeter is highlighted with black squares.
- Click anywhere on the perimeter (notice the open hand cursor) and drag.
Move a text box or a label separately
Generally, Access forces you to move text boxes and their corresponding labels together. However, you may want to move a label or text box without moving its partner.

- Place the cursor over the **upper left-hand corner** of the field or label.
- The cursor will change into the **pointing-finger** cursor.
- Drag the field or label to a new location.

Tip: Moving report elements between sections
You can move both text boxes and labels between sections using the open hand cursor to drag the report elements across the section boundary.

- To move an individual text box or label to another section (for example, you wished to move a label into the report header section):
  - Select the report element you wish to move and cut it from its present location.
  - Click in the section where you want to move this label or text box, and paste it into the section.
  - Drag the element from the section’s top left corner (using the pointing-finger cursor) into its new position.
**Tip: Aligning report elements**

Although you can utilize *Design View’s* grid to align your report elements relative to each other, Access can also align those elements for you.

- Select the report elements you wish to align by simultaneously holding down the *Shift key* and selecting each element.
- Right click on one of the elements.
- From the menu that appears select the *Align* submenu.
- From the *Align* submenu, select the alignment type you prefer.

---

**Resizing text boxes and labels**

Sometimes, the font size or style you choose will obscure text beyond the edges of your text or label box. In this situation, you must resize the control.

- Select the text box or label you wish to resize.
- Drag one of its black square handles so all of your text is displayed.
Saving your report
Be sure to save your report frequently!

- From the **File** menu, select **Save**.
- Give your report a descriptive title. A good title will look like this: *rpt_student names & pay rates*.
  - This title follows a standard naming convention (which holds that each report’s name should be preceded by the `rpt_` prefix to make every report easy to identify).
  - The report’s name also plainly describes the data that the report will display once it is opened.
- Click on the button labeled **Save**.

Reformatting text styles
**Changing Text Styles**
To change the text of either a label or a text box:

- Click on the control you wish to change.
- Click on the down-facing arrow located next to the **Font Style** or **Font Size** box on the **Report Reformatting** toolbar.
  - From the drop-down menu that appears, select the desired font style.

- From the drop-down menu that appears, select the desired font size

**Tip:** Resize a field or label after applying text formatting if not all of the field’s data or label’s text can be displayed.
**Changing Text Colors**

To change the color of the text in a text box or label:
- Click on the control you wish to change.
- Click on the down-facing arrow located next to the **Font/Fore Color** button found on the **Formatting** toolbar.
  - From the drop-down menu that appears, select a color.

**Adding and formatting borders**

**Adding Borders**

To add a border to your field or label:
- Click on the control you wish to change.
- Click on the down-facing arrow located next to the **Line/Border Width** button on the Formatting toolbar.
  - From the drop-down menu that appears, select the border thickness you wish to apply.
  - Access will place the selected border thickness around your field or label.

**Tip: Right-click to Add Borders**
- By simply **right clicking** on a control, you may select a border thickness from the **Special Effects** menu.
Adding color to a border
To add color to a border:
- Click on the control you wish to change.
- Click on the down-facing arrow located next to the **Line/Border Color** button on the Formatting toolbar.
  - From the drop-down menu that appears, select the color that you wish to apply.

Changing Background Colors
To change the background color of a textbox or a label:
- Click on the control you wish to change.
- Click on the down-facing arrow located next to the **Fill/Back Color** button on the Formatting toolbar.
  - From the drop-down menu that appears, select the color you wish to apply to your background.
To change the background color of an entire section:
- Select the section by clicking anywhere on its grid.
- Click on the down-facing arrow located next to the Fill/Back Color button on the Formatting toolbar.
  - From the drop-down menu that appears, select the color you wish to apply.

**Tip: Right-click to Change the Color**
To easily change the color of your text, control background, or section background:
- Right-click on the section or control you wish to change.
- From the menu that appears, select a background color from the Fill/Back Color submenu or a text color from the Font/Fore Color menu.

Using images
**Inserting an image**
- Select the section of your report where you wish to insert your image.
- From the Insert menu, select Picture.
- The **Insert Picture** window will appear.

  ![Image of Insert Picture window]

  - **Navigate to the picture’s location on your hard drive or network drive.**
    - Select the image you wish to insert.
    - Click on the button labeled **OK**.

  To move the image once it has been inserted:
  - Click on the image to select it.
  - Place your cursor anywhere above the image (watch for the open hand cursor).
  - Click and drag your image to a new location.
Resizing an image proportionately

- Right-click on the image you wish to resize.
- From the menu that appears, select **Properties**.
- The **Image** window will appear.
- Click on the tab labeled **Format**.

- Click on the down-facing arrow located next to the box labeled **Size Mode**.
- From the drop-down menu that appears, select **Zoom**.
- Close the **Properties** window.
- Drag one of the corners or side handles to resize the image, just like resizing a field or text box.

*Tip: To crop an image so that less is displayed, utilize the **Clip** size mode (instead of zoom) and then drag to resize the image’s box. Just as you see less of the scenery outside your window upon lowering a shade, you see less of your image as you make the image’s box smaller.*

Adding Borders to an image

- Right-click on the desired image
- From the drop-down menu that appears, select **Properties**.
- The **Image** window will appear
- Click on the tab labeled **Format**.
- The following table describes what border properties you may edit:

<table>
<thead>
<tr>
<th>Box Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border Style</td>
<td>Choose the type of border you wish to display</td>
</tr>
<tr>
<td>Border Color</td>
<td>Choose the border’s color</td>
</tr>
<tr>
<td>Special Effect</td>
<td>Select an effect to add unique dimensions to the border</td>
</tr>
<tr>
<td>Border Width</td>
<td>Choose the width applied to the border</td>
</tr>
</tbody>
</table>